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Q.No: 1 What population of India is engaged in agricultural activities?
2624295
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Correct Ans : A

Subject : General Knowledge graduate

Q.No: 2 What is a celestial body that revolves around a planet in the same way that a planet revolves around the Sun?
2624351

T Gy s 71 o T U8 & IRT 3R I kG THAT § 98 U U8 Y & IR 3R gAAT 82
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Moon
A
i
Satellite
B
SuTe
Solar system
C
R Hsd
Meteorites
D
IpIfts

Correct Ans : B

Subject : General Knowledge graduate

Q.No: 3 Who entered the Gupta Empire during the reign of Kumaragupta?
2624719

PARW & ARFESHIA J I Iag | [ yawy fdar

Mangole
A

N

Afghans
B

S

Hunas
C

U

All of the given options are incorrect.
D

faw o 9t e Toa §1

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 4 In which of the following journeys will a person have to cross the Tropic of Cancer?
2651236

Fafafad 7 3 feg g & safd 1 b Y@ $I UR HAT g2

A Harda to Khandwa
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el | gsar

Bhopal to Sanchi

B
wiure & i
Khandwa to burhanpur
C
TeaT ¥ WeHR
Balaghat to Mandla
D

graTgIe 9 Heell
Correct Ans : B

Subject : General Knowledge graduate

Q.No: 5  Which of the following cities of Madhya Pradesh is known as ‘City of Royals'?
2651279

e v & Fufafad & ¥ iy wex &Y [Mgal &1 weR (R 3 Jae) w8l o 872

Satna
A

GG

Indore
B

R

Bhopal
C

yiaTer

Jabalpur
D

SIEeYR

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 6  The resolution on Fundamental right and National Economic programme was enacted in which congress session?
2674534

HiftTs SHRIPR 3R AP SN BRIHH BT UG HIE & by ISR H I/ 17 ur?

A Lahore Session,1929
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AR 3AfE=A , 1929

Karachi Session,1931
B

P 3fRdHE, 1931

Lucknow Session, 1916
Cc

@S, JftdwH, 1916

Kanpur Session, 1925
D

PHYR AREM, 1925
Correct Ans : B

Subject : General Knowledge graduate

Q.No: 7 Which among the following is NOT a bulwark of the constitution?

2674799
Praffad & S Ay o1 WReb & 82
Supreme Court
A
SdH AT
Comptroller and Auditor General
B
e wd weTeraT wiars
Union Public Service Commission
Cc
Y A /a1 AT
Attorney General of India
D

YR HT ATt

Correct Ans : D

Subject : General Knowledge graduate

Q.No: 8  Which of the following was a major port city during medieval India, known for its trade with Southeast Asia and
2680667 (hina?

frfifed § 9 o1F-91 Te@aH YR & GRM U6 THE a8 eX T, S Gia0r gd TiRmn $iR 91 & 91y 0= IR & frg
ST ST 412

A Agra
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Calicut

Goa

Tiar

Khandwa

Esdr

Correct Ans : B

Subject : General Knowledge graduate

Q.No: 9 Which of the following forests is not situated in Tamil Nadu?

2680853
Fffad § 9§ &9 91 97 dftrerrs & Rid 78 87
Kalakad Wildlife Sanctuary
A
FATHS AT FRY
Indira Gandhi Wildlife Sanctuary
B
gfewr mih a=aeiia siaRTg
Bandhavgarh National Park
C
FitaTe I IA
Point Calimere Wildlife Sanctuary
D

wWiEe ey aeilg SR

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 10 Which of the following details are not required to transfer funds through NEFT?
2681626

fafafed & & 19 91 fJaR0 TIRUGE & Ty § o7 ST YTaH HA J SHaRad ol 62

A Consumer Id
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SUMIET ATEST
IFSC code of beneficiary’s branch
B
Taddl St MG BT IFSC TS
Account number of beneficiary
Cc
T dl ST @ral Fa
Name of bank of beneficiary
D

UTedd] 9 BT A
Correct Ans : A

Subject : General Knowledge graduate

Q.No: 11 Which of the following tournaments does the team Dabang Mumbai play in?
2683654

S aa e Prufred @ B9 @ o 3 Qe 27

Indian Premier League

A
$feT ftrR o
Indian Super League
B
gfeaa g &
Hockey India League
C
gt §fear o
Pro-Kabaddi League
D

m-Hagt dhT
Correct Ans : C

Subject : General Knowledge graduate

Q.No: 12 What was India's rank in the RSF 2022 World Press Freedom Ranking?
2683697

3R.TY. Th. 2022 I8 U WBieH I & HRd BT I o1 UT?
136

136
B 142
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142

150
C

150

156
D

156

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 13 Which organization recognizes outstanding contributions in the field of mathematics with the Fields Medal?
2684874

B TGS Blegy Hsd & 1Y T & & H Ip¥ GRIGH oY ARGl el 82

International Mathematical Union

A

st mftrdt v

American Mathematical Society
B

ART RyAfesa drargd

European Mathematical Society
c

QRId Tt St

London Mathematical Society
D

de TR JRImadt
Correct Ans : A

Subject : General Knowledge graduate

Q.No: 14 How many times was the Preamble of the Constitution amended?
2685248

Tfge o1 ukareT § fean) IR e fBar mar

Three times

IR

B Two times
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AR

Once
C

Td IR

None of the given options
D

o e fawent A @+ TE
Correct Ans : C

Subject : General Knowledge graduate

Q.No: 15 Sania Mirza has announced her retirement recently. She is related to which sport?
2691652

i firetf 3 g € & oge ST o @ 9w Y 21 98 fhg 9 & deftd 22

Baseball
A

JHara

Chess
B

RICEE |

Cricket
c

fpdpe

Tennis
D

¢

Correct Ans : D

Subject : General Knowledge graduate

Q.No: 16 Chanakya was the chief advisor of which ruler ?
2733182

U (6 TS & T AGHR A?

Chandragupta Maurya

e W
B Kanishka
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s

Rajyavardhan singh rathore
c

Tegat Rie wets

Sikander
D

Ryéae

Correct Ans : A

Subject : General Knowledge graduate

Q.No: 17 Which of the following element is used in the process of galvanization?
2733339

TreaiRur o1 ufsean & Fofefaa # @ feg aa &1 IuaiT fear S 82

Sodium
A
HifeaH
Copper
B
PIWR
Zinc
C
i
Tin
D
fea

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 18 Identify the segment in the sentence which contains the grammatical error from the given options.
2621227

It’s normal to be scary during an earthquake, which can rock the ground like a boat in rough water.
A It's normal to be scary
B during an earthquake
C which can rock the
D ground like a boat

Correct Ans : A

Subject : General English graduate
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Q.No: 19 Identify the segment in the sentence which contains the grammatical error from the given options.
2621235
Once the wettest place on Earth, Cherrapunji, a town in northeastern India, has face a drought each winter for the

past few years.
A Once the wettest place
B a town in northeastern India,
C has face a drought each winter
D for the past few years.

Correct Ans : C

Subject : General English graduate

Q.No: 20 Select the most appropriate meaning of the given idiom.
2631498

Get on one’s nerves

A To irritate
B To be impatient
C To try to copy

To follow aimlessly
Correct Ans : A

Subject : General English graduate

Q.No: 21 Find the most appropriate option for the given blank space which can make the given sentence grammatically and
2648552 contextually correct.

The children are always when they get home from school.
A anger
B freshly
C hungry
D eagerly

Correct Ans : C

Subject : General English graduate

Q.No: 22 Select the correct synonym of the given word.

2675209
FLAGRANT
A blatant
B inconspicuous

concealed

(@]

unobtrusive

Correct Ans : A

Subject : General English graduate
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Q.No: 23 In the following question, a sentence has been given in Active/Passive Voice. Out of the four alternatives
2675920 suggested, select the one which best expresses the same sentence in Passive/Active Voice.

He rang the temple bell loudly.

A The temple bell was rung loudly by him.
B The temple bell was rang loudly by him.
C The temple bell had been rung loudly by him.

The temple bell has been rung loudly by him.

Correct Ans : A

Subject : General English graduate

Q.No: 24 In the following question, a sentence has been given in Direct/ Indirect speech. Out of the four alternatives
2676211 suggested, select the one which best expresses the same sentence in Direct/ Indirect speech.

"Politics still interests me, but I avoid discussing it," I said.
I said that politics still interested me, but I avoid discussing it.
I said that politics still interested me, but I avoided discussing it.

I said that politics still interests me, but I avoid discussing it.

o 0O w >

I said that politics still interests me, but I avoided discussing it.
Correct Ans : B

Subject : General English graduate

Q.No: 25 In the following question, a sentence has been given in Direct/ Indirect speech. Out of the four alternatives
2676318 suggested, select the one which best expresses the same sentence in Direct/ Indirect speech.

"He is trying his best to collect the money he needs," said the girl.
A The girl said that he is trying his best to collect the money he needs.
B The girl said that he is trying his best to collect the money he needed.
C The girl said that he was trying his best to collect the money he needed.
D The girl said that he was trying his best to collect the money he had needed.

Correct Ans : C

Subject : General English graduate

Q.No: 26 In the following question, four words are given, out of which only one word is correctly spelt. Find the correctly
2676527 gpelt word.

consceince
scrupuluos

conscientious

o 0 W r

manifesting
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Correct Ans : C

Subject : General English graduate

Q.No: 27 In the following question, out of the four alternatives, choose the one which can be substituted for the given
2676745 \yords/sentence.

One that cannot be erased

A connoisseur
B indelible

C heretic

D Convalescent

Correct Ans : B

Subject : General English graduate

Q.No: 28 In the sentence, identify the segment which contains the grammatical error.
2677409

She was pleased at see them and gave them a grand welcome.

A grand welcome
B gave them a

C at see them

D She was

Correct Ans : C

Subject : General English graduate

Q.No: 29 In the following question, one part of the sentence may or may not have an error. Find out which part of the
2677514 gentence has an error and select the appropriate option. If the sentence is free from error, select 'No Error'.

Articulating your reservations about a proposal is the work of acquainting yourself with your own thoughts.
A Articulating your reservations
B about a proposal is the work
C No error
D of acquainting yourself with your own thoughts.

Correct Ans : C

Subject : General English graduate

Q.No: 30 In the following question a sentence is given in Direct/Indirect speech. Out of the four alternatives choose the one
2686495 hich best expresses the same sentence in Indirect/Direct Speech.

He said, “Help! Help!”
A He screamed for me that help.

B He screamed that help help.
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C He shouted for help.
D He has asked for help.

Correct Ans : C

Subject : General English graduate

Q.No: 31 1In the below question, there are five sentences/paragraphs. The sentence/paragraph labelled A is in its correct
2689747 place. The four that follow are labelled B, C, D and E, and need to be arranged in the logical order to form a
coherent paragraph/passage. From the given options, choose the most appropriate option.

A. I had six thousand acres of land, and had thus got much spare land besides the coffee plantation. Part of the
farm was native forest, and about one thousand acres were squatters’ land, what the Kikuyu called their shambas.

B. The squatters’ land was more intensely alive than, the rest of the farm, and was changing with the seasons the
year round. The maize grew up higher than your head as you walked on the narrow hard- trampled footpaths in
between the tall green rustling regiments.

C. The squatters are Natives, who with their families (hold a few acres on a white man’s farm, and in return have
to work for him a certain number of days in the year. My squatters, I think, saw the relationship in a different
light, for many of them were born on the farm, and their fathers before them, and they very likely regarded me as
a sort of superior squatter on their estates.

D. The Kikuyu also grew the sweet potatoes that have a vine like leaf and spread over the ground like a dense
entangled mat, and many varieties of big yellow and green speckled pumpkins.

E. The beans ripened in the fields, were gathered and thrashed by the women, and the maize stalks and coffee
pods were collected and burned, so that in certain seasons thin blue columns of smoke rose here and there all
over the farm.

A CBDE
B CBED
C BCDE
D DBCE

Correct Ans : B

Subject : General English graduate

Q.No: 32 In the following question given below, a sentence is provided with two blanks. Choose the correct combination of
2727921 \yords that fit into the corresponding blanks.

for tests on the immuniser developed in India will serve to the efficacy, safety and
consistency between vaccine batches.

approved, assessing
approval, assess

approval, assessed

o 0O W >

approved, assess
Correct Ans : B

Subject : General English graduate
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Q.No: 33 Select the most appropriate option to fill in the blank.
2729026

He believed that he had struck terror in his children's hearts because of his

A love

B rage

C calmness
D distress

Correct Ans : B

Subject : General English graduate

Q.No: 34 Select the most appropriate synonym of the given word.

2729243
DELIGHTED
A Coarse
B Unsuited
C Disliked
D Joyful

Correct Ans : D

Subject : General English graduate

Q.No: 35 Which of the following statements about ICMP (Internet Control Message Protocol) might be true?
2635713

ICMP (33T drgid Bl Mietdieh) & aR § Fafifad & § SH-T1 U7 I 8 TdhdT 82

It reports all errors which occur during transmission

A
g TRV & SR g arelt guft Ffea) it Ruld swar @
A redirect message is used when a router notices that a packet seems to have been routed wrongly
B
TP SSTaae W $T IUGNT a9 {591 ST § 99 U ASer A ovdl & f o Ydbe Tad a6id @ Fe forar
It informs routers when an incorrect path has been taken
C
TTEd IRAT YA R Y A3 B JRId a1 8
The “destination unreachable” type message is used when a router cannot locate the destination
D

"Tided 3R (destination
unreachable) TR &1 T da IUANT fHUT SITdT § ST IS Tided BT Il T8 ¥ bl @

Correct Ans : B

Subject : General Computer Graduate
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Q.No: 36 BASIC is a computer language, what is its full form?

2635781

BASIC U $UeR M 7, HHT Yol & o1 37

Beginners' All-purpose Symbolists Instruction Code
A

fafird sna-udw Riaifined s @i

Beginner’s All-purpose Symbols Instruction Code
B

fafi sifa-uds Rivew sea—H Fis

Beginner’s All-purpose Symmetry Instruction Code
c

fafie sifa-uds Rt Sgame ois

Beginner’s All-purpose Symbolic Instruction Code
D

Correct Ans : D

Subject : General Computer Graduate

Q.No: 37 FPS is the frequency at which consecutive image/jpgs are captured or displayed. What is its full form?
2635804

FPS 98 WIdal ¢ foR TR AR 30 H&R &I Sl ¢ a7 Uaiid $I oIl ¢ | 3P FAnhIH o1 g2

File Per Second

A
BIsd W Ahs
Flow Per Second
B
W W dbs
Flops Per Second
C
WY W A5S
Frames Per Second
D

A R s

Correct Ans : D

Subject : General Computer Graduate

Q.No: 38 Which of the following is not an example of hardware?
2635893
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fofafed o I HI9-91 STEIWR HT ISR Tal 82

Scanner

R

Monitor

Hidtex

Printer

fiflez

Interpreter

Correct Ans : D

Subject : General Computer Graduate

Q.No: 39 Which is the menu to create a text box on a slide?
2636077

e W RS Fag 91 & o Bg HH-37 82

View -> Text Box

A
 -> TRE I
Insert -> Text Box
B
¢ -> THRT gl
Format -> Text Box
C
Bide -> TR qI
Tools -> Text Box
D

TR -> TRe qid
Correct Ans : B

Subject : General Computer Graduate

Q.No: 40 What is the purpose of data loss prevention (DLP) software in computer security?
2636947
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SR e § a1 Y T (DLP) IIediR &1 3229 1 872

To prevent the loss or theft of sensitive information

A
HagTiie ST & JHar a1 T B AP F g
To protect against malware
B
Aerder & g9 & g
To encrypt data
C
Se1 TfSpE $1 & frg
To prevent data breaches
D

3T YAl (breaches) &t Ad & g
Correct Ans : A

Subject : General Computer Graduate

Q.No: 41  Which of the following operating systems doesn't have a firm owning and licensing it?
2638929

fFrafafad # J fog sifrfeT Rken & urg @13 BH 76l & 3R 3HPT a1gdd T8 g7

Windows
A
fastar
Mac
B
A
Unix
C
g
None of the given options
D

2w 7T Rl § @ 915 98
Correct Ans : C

Subject : General Computer Graduate

Q.No: 42 The internet service that provides 'audio' and 'video' conversations is called:
2645145

geAe 31 a8 Ja1 &I, S Hif$al ud S arafan vem F=dl ], Heard &
A Chat
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de
E-mail
B
3-7a
Video Conferencing
C
FifSar SR
Voice Call
D

qsd DA
Correct Ans : C

Subject : General Computer Graduate

Q.No: 43 Who out of the following introduced the concept of stored-program computers which was capable of storing data
2675298 45 well as programs in the memory?

fafafed & 9 foem STEia-um (TR-UUH) $WeR & YR U &I ol ST & Ary-9rd FURT T UM &I WRId (TR)

S | & ur?
Alan Turing
A
Ta egfe
Herman Hollerith
B
&0 gAY
John Von Neumann
C
S gt A
Blaise Pascal
D

= U
Correct Ans : C

Subject : General Computer Graduate

Q.No: 44 In which of the following services do users need to log in to a server computer remotely, and then to log out again
2675314 \yhen the user finishes accessing information on the server computer?
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frafefad & § feg Yar & SuaTeaial & R T YR SR H AT 37 B B AT gidl 7, 3R R Sig IqtivTehd
TR HYR R TGN TR AT JAE HR ddl ¢ o fo @l 3M13e AT ugdm 872

NetScape
A

qewhy

Mozilla
B

HifSren

FTP
C

THedt

MacWeb
D

Apaq

Correct Ans : C

Subject : General Computer Graduate

Q.No: 45 Which technique is used to hide the information in a picture?

2675671
fepeft Forr & sl 1 UM & U fob qepeiiep a1 T fobarm Sirell &2
Cryptography
A
[Egueiial
Forensics
B
RS
Steganography
C
RoTEH
Image rendering
D
ofa yfdure

Correct Ans : C

Subject : General Computer Graduate

Q.No: 46 What is the purpose of BIOS shadow?
2678186
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Raraiivy BT B I T 82
Copying RAM to ROM

A
X9 & AW | BIY HAT
Coping ROM to RAM

B
I DY I A BIG HAT
Copying HD to RAM

Cc
TR B 3 F B R
Copying RAM to HD

D

YW B grEfewd § SIdt BT
Correct Ans : B

Subject : General Computer Graduate

Q.No: 47 Which one of the following is a text function in MS Excel?
2678256

Fafied & @ B9 91 THTY Teld § Th SRe thauH 82

MID()
A
MID()
NOW()
B
NOW()
COUNT()
C
COUNT()
SIGN()
D
SIGN()

Correct Ans : A

Subject : General Computer Graduate

Q.No: 48 Which modern technology is used by the majority of grocery retailers to enter the product code?
2680420

IJAIG IS &Sl B P oY ARIHI fb=rT et fasharsit gRT {5 sy adb-ites o1 IuanT fova Sirar g2

A Interface/Pick Devices
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%W / o fEargw
Touch Screens
B
T B
Light Pens
Cc
SIECAE |
Scanning devices
D

Wi fEagy
Correct Ans : D

Subject : General Computer Graduate

Q.No: 49 What type of input device does video game use?
2680421

R 1 59 UBR & F9YC fEared &7 IuahT FHal 82

Joystick
A
SrafRes
Digitising tablet
B
fSforersfom eade
Trackball
Cc
rodta
Mouse
D
sy

Correct Ans : A

Subject : General Computer Graduate

Q.No: 50 Which of the following is an output device?
2684603

fgfafed # ¥ $H-I1 U 33eye f3asy 8?2

A Printer
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Google Play

fliex

Monitor
B

Hifex

Mouse
C

HISYH

Printer and Monitor both
D

fifex 3k wifer gAY

Correct Ans : D

Subject : General Computer Graduate

Q.No: 51 Select the option that is related to the figure in the same way that the second figure is related to the first figure.
2629421

~J

39 fahey o1 78 B off TR 31pfal § I e Tt § I ot 3pfa Ugeht omepfa & Weifdra &1

o | i B i e
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LK
h
h
dr
d-

Correct Ans : A
Subject : General Aptitude Graduate

3satozo If (2x + 3y +42) = 0, find the value of (8 + 27y + 642%).

TfE (2x +3y+42)=0 T @Y, (833 + 27y + 6423) T AT AT -

42xyz
A

42xyz

72xyz
B

72xyz
c 36

xyz
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36

XYVEZ

32

XVEZ

32

XVZ

Correct Ans : B

Subject : General Aptitude Graduate

Q.No: 53 In the following question, select a figure from amongst the four alternatives, which when placed in the blank
2642164 space of figure (X) would complete the pattern. Identify the figure that completes the pattern.

Pofifad oy &, IR orepfa § § Ue Ml o1 7g- By, R od 3Mefd & @rell I (X) & @1 Sl 2, df ded @1 8 1
I MBI BT uga™ ot Yo Bl IRT FHral gl
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~J

Addal2H

Google Play

Vi

Y@VIVRY

Correct Ans : C

Subject : General Aptitude Graduate

Q.No: 54 Eight friends J, K, L, M, N, O, P and Q are sitting around a circle facing the centre. J is not the neighbour of N. L is
2663907 third to the right of K. Q is second to the left of N who is next to the right of L. O is not the neighbour of N or K
and is to the immediate left of P.

Which of the following is the correct position of L?

e T3, K, L, M, N, O, P 3R Q H% & 3R T b T g & dIRI 3R 96 &1 J, N BT USRI 8l 81 L, K & & I T ]
QNF I ITRVEAWE, o L F <& I AT 1 O, N I K FHT TSI T8 § 3R 9% 31 a1 P B

fofafed 7 3 L &) udt Rufa o9 @ #2

To the immediate right of N

N & 3% <

To the immediate right of Q

Q ¥ di& e

To the immediate left of L
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L & 3 Ird

To the immediate left of Q

Q¥ Sp I
Correct Ans : B

Subject : General Aptitude Graduate

Q.No: 55 In the following question select the odd word pair from the given alternatives.
2665138

f=fafed o= ¥ fou 7T fadedt & & faww wreg gm &1 999 H

Desert: sand

A
I ¥
Grassland: grass
B
T $T A9
River: water
C
T4
Forest: Jungle
D

9 ST
Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 56 Which set of letters when sequentially placed at the gaps in the given letter series shall complete it?
2665168

SFHHE FU Y TS 3R g@ar H Rad RIFl IR 3@ TH W 34eRT BT HH-I1 T4 U T HA?

ab__a_c_a

cbdab
A

cbdab

cdbbd
B

cdbbd

C cdddd
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cdddd
cdbdb

cdbdb

Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 57 Two pipes X and Y can fill an empty tank in 16 hours and 20 hours respectively. Pipe Z alone can empty the
2670464 completely filled tank in 25 hours. Firstly both pipes X and Y are opened and after 6 hours pipe Z is also opened.
What will be the total time (in hours) taken to completely fill the tank?

A X R Y TS Wielt Tt Y HUR: 16 S 3R 20 9 H WR bd g1 T Z 3fbal guia: U g3 ST &Y 25 e T Wrelt R
THdl g1 T8 X 3R Y GFf 9d Wi 9 8 3R 6 8¢ & 1 9 Z +} Wa o g1 <t &l guid: RA & forg foran man oot g
(ge #) w1 gnm?

80/7

80/7
67/7

67/7
28/3

28/3
304/29

304/29
Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 58 Ifin 3 years at simple interest the principal increases by 18%, what will be the compound interest (in Rs.) earned
2673183 Rs.25,000 in 3 years at the same rate?

g 3 auf o WYRY S R AT 18% J §¢ ofdT §, dl S &R W 3 I A 25,000 3. R i ashgla = (3. 7) Fa1 grme
4775.4

4775.4

B 5774.5
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5774.5

4557.4
Cc

4557.4

5575.4
D

5575.4

Correct Ans : A

Subject : General Aptitude Graduate

Q.No: 59 Directions: Four statements and Three conclusions are given in this question. Read the statements carefully and
2679763 nderstand which of the conclusions are correct by logically.

Statements:

Some red are blue.

All white are blue.

All yellow are red.

Some white are orange.
Conclusions:

I. Some white are yellow.

II. Some orange are definitely red.

III. At least some blue are orange.

e 39 Uy A IR By 3R i ey faT T B | Ul & e @ ue 3R I f i | ey arfdhe wu ¥ I8t B
FY:

PS A A1 §

Tt wthe i g

wft it ot g

TS g AR g

e

1. $S ghe Ui §1

I1. $& A0 Ff¥d w9 & 9 g

III. &7 ¥ $H & I TR0 §1

both conclusions I and III follow

S forepd 1 SR 11T SR ad §

B only conclusion III follow


https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD

Addaic47 Eoogle Play

Faa frssd 111 SRR HvaT @

both conclusions I and II follow
C

31 el 1 SR 11 3R B §

both conclusions II and III follow
D

Y e 11 SR 11T 3rERor oa &

Correct Ans : B

Subject : General Aptitude Graduate

Q.No: 60 A shopkeeper sells 90 litres of mustard oil in Rs.8730 at the profit of Rs.12 per litre of mustard oil. What is the
2695621 (gt price of 1 litre of mustard oil?

TP gHMER 8730 IUY H 90 THer TN HT A, 12 diex WA & dd & aH W 9gdl g1 1 diex IR & I BT 53 Jod T 82

Rs.90
A

90 W

Rs.95
B

95 Il

Rs.80
C

80 IW

Rs.85
D

85 W

Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 61  Which number will replace the question mark (?) in the following series?
2698519

5,8, 20, 34, 76, 142, ?

fafafad saar & uy fomg (2) & WM R 19 I G smwfi?

5, 8, 20, 34, 76, 142, ?
A 272
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272

296

296
284

284

302

302
Correct Ans : B

Subject : General Aptitude Graduate

Q.No: 62 From the given alternatives, select the word which cannot be formed using the letters given in the word.
2698586
INTERNATIONAL

13U gu fasedl & A 39 e 1 MU ol F2 AT 7T Woa # A 31&RT J &9 G Fobell Bl
INTERNATIONAL

TERMINAL
TERMINAL

RATIONALE

RATIONALE

INTERNAL
INTERNAL

LANTERN

LANTERN
Correct Ans : A

Subject : General Aptitude Graduate

Q.No: 63 Find the figure from the answer figure that will replace the question mark (?) from the problem figure.

2755671
Ia

Question Figure:

®-||[°]

=)

IR AP Y 98 NP 1d IFTT S THAT AP J Heraress fog (?) o ufaafid &R 31
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.;:m“h_\.: ?
A\
A\
A\
A\
A
A\
AN
/N

Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 64 Find the figure from the answer figure that will replace the question mark (?) from the problem figure.
2755691

Question Figure:

NINIBE
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TR NPT T T8 B F1d BT ST TR APl T Tsrarass e (?) B ufawaiiod &R 2|

NIINSE
®
®
®
®
©
©
D

o)

Correct Ans : C

Subject : General Aptitude Graduate

Q.No: 65 In a certain code if 'M' denotes'+', 'N' denotes 'x', 'O' denotes '+' and 'P' denotes '-', then what will be the value
2755716 of 16M4N305P3M3?

Tfe teh g Sl uwr § '™, ' B WA 8, 'N', 'x' B <WidT ], 0", '+' B =i § 3R P,
'~ &Y eWIdT 8, & 16MAN305P3M3 &1 HIF fahamT BITTI?

A 14
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14

15

15
16

16
17

17
Correct Ans : C

Subject : General Aptitude Graduate

Q.No: 66 Three positions of a cube are shown below. Which numbers will come on two faces marked ‘A’ and ‘B’ in the fourth
2755730 position?

| 4 6
2‘5 6 |° 1‘2 |3|“

TS v B dF Rt 9 ewis 7 §1 o @ g'm 9 Rifa § A 3R B’ & wu # RIfRd 3 sl g

| 4
5 1‘z|3|n

(4, 2)

(4, 2)
(5, 2)

(5, 2)
(6, 5)

(6,5)
(6, 2)

(6, 2)
Correct Ans : C

Subject : General Aptitude Graduate
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Q.No: 67 At three distinct road crossings, the traffic lights change after 15, 3, and 45 seconds, respectively. What time will
2617093 they all change at once again if they all change simultaneously at 11:45:25 AM?

A 3reT- 31T TS dRTE! WR, fhd d1se HHRE: 15, 3 3R 45 Y& & d¢ gad ol 1 afe 3 Tl 11:45:25 Yalg R TH
Y Fead 8, d 9 I T IR R fbda ot sga?

11:45:55 AM
A

11:45:55 AM

11:46:55 AM
B

11:46:55 AM

11:46:25 AM
C

11:46:25 AM

None of the given options
D

faw ¢ el § @ B 98
Correct Ans : B

Subject : General Maths graduate

Q.No: 68 A and B earn in the ratio of 8:9. They spend in the ratio of 5:7 and their savings is in the ratio of 9:7. If their total
2629615 monthly expenditure is Rs. 8400, then the annual salary of B is?

ATUTB 8:9 F UT H HH &1 3 5:7 & UM N g B & a7 9:7 & U H §9d R &1 IS 70T $of Wl
g 8400 ¥UU g, dl B &1 e da b g2

Rs. 84672
A

84672 ¥UT

Rs. 77526
B

77526 ®UY

Rs. 80154
C

80154 ¥UT

Rs. 75256
D

75256 &Y

Correct Ans : A

Subject : General Maths graduate
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Q.No: 69 The average marks of 45 students was found to be 66. If the marks of two students were incorrectly entered as
2643172 33 and 64 instead of 82 and 46 respectively, then what is the correct average?

45 fgenfial & 3Ngd 3% 66 UTT TMT|
gfe 31 faenifal & 3 82 3R 46 & VM W Tad! § HHW: 28 3R 64 forg MU g, O TEt 3hwd 1 g

67.2

67.2
66.8

66.8
66.4

66.4
66.6

66.6

Correct Ans : B

Subject : General Maths graduate

Q.No: 70 The LCM of two numbers is 15 times their HCF. The sum of LCM and HCF is 960. If one of the number is 180, then
2645758 the other is:

& et &1 9.9, 396 .9, HT 15 T g1 .9, 3R A.9. $T I 960 g1 I U WA 180 T, dl okl U= 7

.
.
e
o

Correct Ans : B

Subject : General Maths graduate

Q.No: 71 gimplifyy: 4-(2% 10) % 0
2667138 plf} ( )

U BIGAT: 4-(2 % 10) x 0

A 3
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Correct Ans : B

Subject : General Maths graduate

Q.No: 72 Simplify-
2667329

8x 76+-38x7—-50 _ 30
T T x 12 - 3— 32 108

WA PiforE-

8x 76 +-38x7—-50 _ 30
TR T =12 - 3-— 32 108

4
A

4

5
B

5

8
c

8

6
D

6

Correct Ans : B

Subject : General Maths graduate
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Q.No: 73 The average of the test scores of a class of ‘m’ students is 70 and that of ‘n’ students is 91. When the scores of
2672456 poth the classes are combined, the average is 80. What is m:n?

‘m’ BT BT TP Bl b YIeT P bl BT 3T 70 § YT '’ BT DI H&fl & 3(h! BT 3T 91 g1 S PHemsif & 3! Bl s W
3 80 U BT 81 m:n &1 82

10/13
A

10/13

10/11
B

10/11

11/10
C

11/10

13/10
D

13/10

Correct Ans : C

Subject : General Maths graduate

(22'6N702:6T6 If polynomial x* + x° + 8x* + ax + b is fully divisible by x* + 1, then find the value of a and b.
O sgIe o + 07 + 82 + ax + b, x2 + 1 & gufa: fwifea §, @ a’ 3R b’ F1 AF T S|
a=1b=7

A
a=1b=7
a=2,b=5

B
a=2,b=5
a=2b=7

C
a=2b=7
None of the given option

D

fou e faeeat & @ P Y
Correct Ans : A

Subject : General Maths graduate
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Q.No: 75 The ratio of speed of A and B is 4 : 5 and A loses the race by 200m, then what is the length of the race course?

2672911
A 3R B B! T &7 UM 4: 5 8 3R A, 200 Hex ¥ €18 BR Ol 7, @ 4 F darg bt 82
1000m
A
1000 #t
3000m
B
30007t
4000m
C
4000 Ht
5000m
D
5000 #t

Correct Ans : A

Subject : General Maths graduate

§6N703 07569 A and B together can fmish a work i 36 days. A and C take 1‘% davs more to complete the same work
than that of Band C. A, B and C together complete the work in 24 days. In how many days will A, B and

C finish it separately?

AR BfAE 36 ol # U & 0 & Tdhel ol A R CF FAaw &0 = A7 B 3R
C CART Tk AR FH FRA $ e 7 7 o ofuw s 81 AL B AR ¢ e 24 fed A
FE QU F 81 A BN €35 30 e B & qw Fom

60,72,90
A
60,72,90
60,90,72
B
60,90,72
72,60,90
C
72,60,90

D 90,60,72
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90,60,72
Correct Ans : D

Subject : General Maths graduate

Q.No: 77 There is sufficient food for 2400 soldiers for 60 days and each soldier eats 750 grams every day after 43 days
2673089 900 soldiers left the camp. Now for how many days rest of the food lasted for the rest of the soldiers if each ate
850gram food every day.

2400 IfHT F o 60 feF & oI o HivH § ok e A ufafem 750 I HieH @rar ® 43 fef & s1g 900 Ifew!
F RIfR J T18R Fovdt Sd 81 3@ bt SIam! & forg @M1 fobam &A1 dp I8 81 afe 3@ ufafe s¥e afFe 850 I @I @I

18
A

18

28
B

28

24
C

24

32
D

32

Correct Ans : C

Subject : General Maths graduate

Q.No: 78  ABCD is a thombus and ZABC = 72°, then what is the measure of 2CAD?

2674500
T FAAGHS ABCD 3R LABC=T72% @ LCAD & A fohaar awem?
62°
A
62°
54°
B
54°

c 58°
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58°

520

520

Correct Ans : B

Subject : General Maths graduate

Q.No: 79 12 men, 10 women and 28 children complete a work in 120 days and 6 women, 6 men and 14 children complete
2675174 the same work in 60 days. In how many days will 5 women together complete the whole work?

12 T3V, 10 AfRd 3R 28 §= Th &1 &1 120 ol & T #Ra § a7 6 ARal, 6 TBW 3R 14 T4 TAH S &' 60 ol o I
I g1 5 ARAN Te Iy Agul wHf B fova 3 & g7 e

12 days
A

12 fe=

16 days
B

16 fa=

14 days
C

14 f=

18 days
D

18 fa7

Correct Ans : B

Subject : General Maths graduate

Q.No: 80 Find the LCM of 0.6, 1.8, 0. 36.
2680161

0.6, 1.8, 0.36 &1 @.9. T1d HifoT|

3.6
A

3.6

1.8
B

1.8
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7.2
C

7.2

10.8
D

10.8

Correct Ans : B

Subject : General Maths graduate

Q.No: 81 A shopkeeper gives three successive discounts of 10%, 15% and 25% to his customer on marked price of a
2681525 product. To his another customer he gives 10%, 20% and 20% discounts on the same product. If the difference
between the purchasing prices of two customers is Rs.540, then what is the marked price of each product?

TH gHFER T IAE S g ST W 3TN TEdH BT 10%, 15% 3R 25% HI TAR Fe ol g
3T IR URH HI 98 I IAE W 10%, 20% AR 20% & FT 3T &
I 3 TMEH & T G & 91d BT 3R $.540 g, Al TS IdGA i fafgd S0 o1 82

Rs.215000
A

%$.215000

Rs.228000
B

$.228000

Rs.240000
C

%.240000

Rs.232000
D

%.232000

Correct Ans : C

Subject : General Maths graduate

Q.No: 82 A Man travelled a certain distance by car. One-third of distance travelled at 60 km/hr. Two third of remaining
2688012 5elled at 50 km/hr and the rest at 70 km/hr. Find the average speed of the car.

T% MTEH HR I @ FYd g 99 F=ar 81 & 9w g8 60 fwy/der 3t fd & g 3t 7€)1 [ &1 & fgrE 50 fiy
HeT &t Tfd F 3R AW 75 HHl/ger &t 7fd T I Bl 81 HR Bt 3N T J1d BIfeTg|

50 kmph

50 fo it ufa "er

B 48 kmph
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48 ot ufa der
62 kmph

C
62 et ufa ger
52 kmph

D
52 et ufa ger

Correct Ans : A

Subject : General Maths graduate

Q.No: 83 Four friends A, B, C and D rented a bungalow and promised to share the rent as follows:
2696132
A:B=8:15B:C=5:8,C:D=4:5. What part of the rent C will pay?

IR ST A, B, C 3R D 7 T STl fopr1T TR o 3R fhi ) 59 bR I1en & bl drer fparfb A: B=8:15B:C=5
:8,C:D=4:5. 8dC% TR P foozran =am grme

24
77
24
77
23
77
23
77
25
77
25
77
26
77
26
77
Correct Ans : A

Subject : General Maths graduate

QNO: 84 ot F O HIH-U1 Teg TUTY TH T &t ISR 72

2660111
A JAGH

B TYTHSOT
C kg

D NERCED

Correct Ans : A
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Subject : General Hindi graduate

Q.No: 85 oymiifRd wreg-wigl § @ BH-91 oy ¢ edl &1 T8 IR 27

2660245
A =R, gReftR, Aea
B iR, U, SR

c 9, P, W

D AP, ¢35, STHR

Correct Ans : C

Subject : General Hindi graduate

Q-No: 86  fyptefRd & & weg-gm vordf - onf ~ & Wt orf e BT =TT FIRTE-

2660470
A Tqds/ Y-- YT/ Haad
B 3T - FApe

C 3 - HIaT

D S - 3T

Correct Ans : A

Subject : General Hindi graduate

Q.No: 87 wGraii o1 wepaar wieg, o B Q @ TR

2660708

A ORI
B S

C TR
D R

Correct Ans : B

Subject : General Hindi graduate

Q.No: 88 oy Y @ Rrwrfe el evalud sromdl &1 wa Fiv-

2660891

A M-I, Y- fi5:1-fRsn e R
B TMTETRM !

C B! 1 $§! ! A1R-A

D 3[gT! qTg! qTE-aTe

Correct Ans : D

Subject : General Hindi graduate

Q.No: 89 et & fb_cjaﬁq ERIELE
2661176 iR P

A TS GRT IHT TR S|
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B M A &1 BT Isy faefivor &t ¢
C g=I | Tid 78 IgT STl
D T Iar gl S|

Correct Ans : B

Subject : General Hindi graduate

QNO: 90 frafafm # Q w-a1 a1, PR &1 IaTeRV TE 82

2661203
A IS4l B g™ femm

B g gRT UgT o1 &7 &

C YRAITRIAN gRT Tt Wit 78 Yemg s qod |
D e grRT v foram =i ¥eT 31

Correct Ans : A

Subject : General Hindi graduate

QMo: 91 el 0= sreu faerm & e @ wify G @ W &), el R e A @ R R ot i sifard @ it 32

2661246
A RISCACES

B waTa® g

C fawmaifeaivs fas
D gfrRm fig

Correct Ans : D

Subject : General Hindi graduate

Q.No: 92  Ffifed o & uid e AT T &1 $% 9 IRE s HINTY & I8 Uep 3ol aRkedie; 51 WG, fopR 991 a1 g 1
2661427 Qyme B Y I8 ey &1 99 S

A. Tt oft v & TIeg TR W & 37 ¥ g1 o &1 I &1 el gl
B. fg=t wron & gfY & g ueredf o

C. 3fd: Tollg eql &1 foffT FeRur SR 9 g 9 &,

D. & & o1 & favam fasar man &1

E. Qfds1 fsifa wreal o1 fofit fafRor = &3+ grar g1

A ABDCE
B BDACE
C EDABC

CDBAE

Correct Ans : A

Subject : General Hindi graduate

Q.No: 93 . .
2666427 TP Tg A sl ¢ " g9 a1 H fagwur 2
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A gHu
B ggd
c a
D Jsar
Correct Ans : C

Subject : General Hindi graduate

Q.No: 94 profufRg # Q “aTeteR” &1 R se & 22

2666494
A g&H

B 3TEd
c LI
D Y

Correct Ans : C

Subject : General Hindi graduate

Q-NO: 95 ymfufRr & & ores YT F T8 ISRV BT T FfT-

2666796
A gfe qut St gift ot waa ot st gt
B e e & F AT

C & 39 @1 gHT § |

D Trq ? i a8 ®a Fraw sl

Correct Ans : C

Subject : General Hindi graduate

QNO: 96 fyrarenfesives arem il €1t g7 G U1, BT ) FeaTae are e & @ g

2666928

A 3ig g4 301 T

B T3 TR STTHA | 3UR GeH 21
C 3ifg, g9 78 3me U

D Y, H a1 M &

Correct Ans : B

Subject : General Hindi graduate

26%399777 PR A e T ¥ Ui R
A e

B g

C til

D 5l

Correct Ans : D
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Subject : General Hindi graduate

Q.No: 98
2668138

A
B
C
D

fmfafad o § ‘haa e & 31 8T & -a1eg § ugad ‘%ad’ FuTd &1 TR Jdsu-

HTRYTD
faremafestys
SAYRTEIYD
ESHUED

Correct Ans : D

Subject : General Hindi graduate

GET IT ON
Google Play

Q.No: 99 ffifad U= ® Ui ®u foU MU B1 3= 3 IRE HHES DI 6 IT8 T 1iyuf uRede s &g, fR 39 o1e fou e

2668488

A
B
C
D

fapeal A 4 9 fApeu &1 T P
A TEHI 8 I UBR

B TS &1 ¥ IqP

C WG &1 Uaid g1 a1feul

D 3% &7 o

E iS4 7R
ABDCE
BDACE
EDABC

CDBAE

Correct Ans : C

Subject : General Hindi graduate

Q.No: 100

2731784
A
B
Cc
D

f=fafed & 9 gfce s &1 999 Hiforg-

it
3
GEIE]
S

Correct Ans : B

Subject : General Hindi graduate
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